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I Prologue

i. What is R?

R is a free software environment for statistical computing and graphics (www.r-project.org). It can effec-
tively analyze large-scale datasets, such as those resulting from high-throughput sequencing experiments.
It promotes automated and reproducible analyses of scientific data, creates a wide spectrum of publica-
tion quality figures, and has an extensive library of add-on packages to facilitate many complex statistical
analyses. Because it is free and ubiquitously available (it runs on Windows, Mac, and Linux computers),
your investment in learning R will pay dividends for years to come.

ii. What is RStudio?

While R is very powerful, it is essentially a command line program and is thus not the friendliest thing to
use. Especially when learning R, a friendlier environment is helpful, and RStudio provides this, giving you
things you expect in a modern interface like integrated file editing, syntax highlighting, code completion,
smart indentation, tools to manage plots, browse files and directories, visualize object structures, etc.

From your computer, choose the RStudio application. This will start R under the hood for you.
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II Introduction

i. R is a calculator

1. The Console panel (lower left panel) is where you type commands to be run immediately. When R
is waiting for a new command, you will see a prompt character, >.

2. To add two numbers, type after the prompt:

1 + 2

When you hit return, you should see . . .

[1] 3

3. The answer is of course 3, but what is the [1] before it? It turns out that all numbers in R are vectors,
and the [1] is a hint about how the vector is indexed. To see a long vector of random numbers, type:

rnorm(100)

For now we can ignore the vector indexing; we will learn more about vectors and indexing shortly.

4. R understands basic math. Try typing:

3 - 4

5 * 6

7 / 8

5. The order of operations is kept (PEMDAS). Note the difference between . . .

1 + 2 * 3

and . . .

(1 + 2) * 3

6. You can force R to do integer division using the %/% operator (division symbol inside two percent
signs):

17 %/% 4

and to get the remainder:

17 %% 4

7. You can also compute powers:

2 ^ 4

even with fractional exponents.

2 ^ 4.3

8. R comes with an extensive library of built-in functions.

log(4) # natural log

log10(4) # log in base 10

log(4, 10) # same as above

sqrt(9) # square root

abs(3-4) # absolute value

exp(1) # exponential
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9. Note in the examples above, we have used comments (preceded by the # character). You can type
them if you want but they do not add anything to the work that R does. Comments are not usually
used when interactively typing commands into the Console, but are essential when writing scripts -
stay tuned!

ii. R has variables

1. It can be really useful to assign values to variables, so they can be referred to later. This is done
using the assignment operator (<-).

us.population <- 3.24e8 # From Wolfram|Alpha

us.area <- 3719000 # From Wolfram|Alpha

us.pop.density <- us.population / us.area

us.pop.density

( us.pop.density <- us.population / us.area )

Some notes:

(a) Once a variable is defined, you will see it show up in the environment panel in RStudio.

(b) R will not automatically print out the value of an assigned variable. Type the name of the
variable by itself to see it. Alternatively, wrapping the assignment in parentheses executes the
assignment and prints the result.

(c) Case matters: US.area is not the same as us.area.

(d) Word separation in R is traditionally done with periods, but this is slowly losing favor. Other
options include snake case (separated by underscores) or camelCase (capitalize each new word).

2. Often, “quick and dirty” variable names that you will be using often in the Console are named with
single letter variables, whereas variables in a script are long enough to be self-explanatory.

Tip: Note that in RStudio, the Tab key will attempt to autocomplete the variable or function
name that your cursor is currently on.

3. Use the rm() function to get rid of a variable from your environment.

rm(us.pop.density) # gets rid of the us.pop.density variable

Note that removing variables from your environment can help reduce clutter and is essential when
dealing with large objects.

iii. Working with environments and history

1. You can save your environment (the set of variables you have defined). To do so, click the Save icon
in the Environment tab (top right). Once you have saved your environment, the actual R command
that was run pops up in your Console. Note that RStudio automatically adds the traditional file
extension of .RData.

2. To clear your current environment, click the broom icon on the Environment panel. You can also
achieve this by typing:

rm(list = ls(all = TRUE))

Note that all the variables you just defined have disappeared!
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3. To load an environment, click the Load icon and select the .RData file that you saved earlier. Again,
you’ll see the corresponding R command in the Console panel. Note that loading an environment
does not empty your existing environment, but it will overwrite any existing variables.

4. It is good practice to have a separate directory for each project or analysis that you are working
on. If you tell R about this directory, it will, by default, load and save files from it. We call this the
working directory. You can browse files and directories from the Files tab of the lower right panel.
Set the working directory using the gear icon (the More button). Alternatively, you can use the
ctrl-shift-H shortcut. Once run, the R command to set the working directory is also shown in the
Console tab.

5. When you quit R, you will be asked if you want to save your workspace image (meaning your
environment) in your working directory in a file called .RData.

6. RStudio always saves your history in your working directory. This can be a problem when restarting
RStudio just by clicking on the Dock or the Start menu as your working directory will be your home
directory and you will not see the history saved from your last session. On Macs, an easy way to
specify your project directory when starting R is to drag the folder you want onto the RStudio icon.
For Windows, the icon in your Toolbar does not work; you will have to use an alias on your Desktop.
This will also load any saved .Rdata and .Rhistory files from that directory.

7. An even better practice is to create a new RStudio project for every analysis. This is RStudio’s way of
supporting and streamlining the common practice of keeping all the input data, R scripts, and other
files associated with that analysis together. This will create a .Rproj file in your project directory.
Now, whenever you want to work on that analysis again, opening that .Rproj file will bring you back
to exactly where you left off (the same working directory, the same files open, the same command
history), although you’ll have to re-populate your environment.

8. Note that you can easily copy a line from your history to the Console by double-clicking it, or using
the To Console icon.

iv. Getting help

1. Much work has gone into making R self-documenting. There are extensive built-in help pages for all
R commands, which are accessible with the help() function. Thus, to see how sqrt() works, type:

help(sqrt)

The help page will show up in the Help section of the RStudio window. In case typing help is too
long, there is a shortcut.

?sqrt

2. It should be noted that some special characters or reserved words have to be quoted when using
either of the above help functions.

?"+"

will show the help page for the arithmetic operators. Note that since the + function is just one of a
group of similar operators, the help page explains all of them in a single page, rather than having
separate pages for +, -, *, / etc. The help pages quite often will group similar functions together this
way (e.g., the related functions log() and exp() are found on the same page).

3. Another very useful command is the example() function. Almost all R commands will include a
series of examples on their help pages (accessible using the help() or ? functions). You can run these
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examples directly from your console by using the example() function. To see the examples for the
sqrt() function, type:

example(sqrt)

This runs the set of examples that are listed at the bottom of the help page, exactly as if you had
typed them out yourself.

4. The R help is not always as transparent as one would like and StackOverflow (stackoverflow.com)
may be a better bet for answering your questions.

v. Data types

1. So far, we have only been dealing with numerical data, but in the real world, data takes many forms.
R has several basic data types that you can use.

has.diabetes <- TRUE # logical (note case!)

patient.name <- "Jane Doe" # character

moms.age <- NA # used to represent an unknown ("missing") value

NY.socialite.iq <- NULL # used to represent something that does not exist

2. When working with truth values, you can use the logical operators:

AND (&)

OR (|)

NOT (!)

is.enrolled <- FALSE

is.candidate <- has.diabetes & ! is.enrolled

3. R uses tri-state logic when working with truth values.

TRUE & FALSE

T | F

T & NA

F & NA

TRUE | NA

FALSE | NA

TRUE & ! FALSE & NA

4. R can convert among datatypes using a series of as.() methods.

as.numeric(has.diabetes)

as.numeric(is.enrolled)

as.character(us.population)

as.character(moms.age) # still NA - we still don't know!
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III Keeping your code

Up to this point, we have been using the interactive console panel of RStudio. We have seen that the
history panel keeps a record of what we have done, but what would happen if we quit RStudio and
did not save the .Rdata? The objects in our environment would disappear, and we would have to trawl
through the command history, remember those commands that worked, and re-run them to recreate our
environment.

There are two ways in which we can keep track of which commands we want to run to re-generate our
analyses, both of which use the Source panel.

i. R scripts

A best practice is to store R commands in a script file. Choose File ⇒ New File ⇒ R Script, or from the
green cross icon, choose R Script. An empty tab should appear, which you can populate with R commands,
exactly as you would type them in the Console panel. You can use the Console panel to engineer the
command to do exactly what you want, then copy it to the Source window. An easy way to do this is to
highlight the command in the History panel and click the ‘To Source’ button.

From the Source panel, you can run a single line (that the cursor is on), or a selection of highlighted lines
(Mac users press cmd-return). Clicking the Source button will run all the commands in the script, from
start to finish. Note that nothing will be printed to the Console window unless explicitly declared, or you
use the ‘Source With Echo’ option, which will print both the command and any output.

A good practice is to periodically empty your environment (but not your history - you might need it!), and
try to re-create it using just the script. This will let you know if you have inadvertently missed adding a
crucial command!

ii. R Markdown

This is a way of combining not just the code, but also notes and comments about the code and project.
It can be thought of as akin to a lab notebook, which you can use to capture scientific ideas and the
associated analysis results and communicate these with colleagues.

To start a new R Markdown document, choose File ⇒ New File ⇒ R Markdown, or select R Markdown
from the green cross icon. You will be asked to fill in some basic metadata (name of document and author)
and what you want the default output format to be.

There are three parts to an R Markdown document:

1. a YAML header, surrounded by triple dashes, which is automatically generated for you when you
open a new document

---

title: "Some title"

author: "Luce"

output: html_document

---
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2. the chunks of R code that will be run, surrounded by triple backticks (```)

``` {r optional_name, optional_options}

R code here

```

3. text, with Markdown formatting.

To produce a complete report including code and text, click the Knit button. If you haven’t already saved
the file, it will ask you to do so now. Try this now, with the default content given to you on creation.

By default, an HTML file will be produced, with a preview either in the Preview panel, or externally (which
preference can be set from the Options menu (the cog icon)). The HTML file can be sent to colleagues or
your PI, and viewed in a browser. Other output options include PDF and Word, although you will need
to install separate packages for that functionality. We will talk more about external packages in a later
section.

Each R code chunk can be run separately. The output from each chunk can include both the code and
the results (use echo=TRUE as a chunk option) or just the results (use echo=FALSE). The output, including
figures, may be shown inline (in the .Rmd file), but many people find this distracting, and prefer to see the
output in the Console and Plot panels, which can be set from the Options menu (select Chunk Output in
Console).

It is also possible to include mini-code chunks inline, surrounded by single backticks, and prefixed by the
letter r. These will get evaluated, and get filled in, whenever the document is knitted.

The formatting of the text is accomplished with standard Markdown formatting. Examples include:

• Different level headings are prefixed by varying numbers of #.

• Italic or bold text is surrounded by one or two *, respectively,

• Bulleted list items are prefixed by *,

• Numbered list items are prefixed by numbers.

There are a number of guides to help you construct your R Markdown documents directly from within
RStudio:

• an external R Markdown cheatsheet PDF, which lists all the most commonly used commands and
syntax, accessed from Help ⇒ Cheatsheets ⇒ R Markdown Cheat Sheet,

• an external markdown reference guide PDF, accessed from Help ⇒ Cheatsheets ⇒ R Markdown
Reference Guide, also found inline at Help ⇒ Markdown Quick Reference.
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IV Data Structures

i. Overview

R has several different types of data structures and knowing what each is used for and when they are
appropriate is fundamental to the efficient use of R. The ones that we are going to examine in detail here
are: vectors, matrices, lists and data frames.

A quick summary of the four main data structures:

Vectors are ordered collections of elements, where each of the objects must be of the same data type or
mode, but can be any mode.

A matrix is a rectangular array, having some number of columns and some number of rows. Matrices can
only comprise one data type (if you want multiple data types in a single structure, use a data frame).

Lists are like vectors, but whereas elements in vectors must all be of the same type, a single list can include
elements from any data type. Elements in lists can be named. A common use of lists is to combine multiple
values into a single object that can then be passed to, or returned by, a function.

Data frames are similar to matrices, in that they can have multiple rows and multiple columns, but in a
data frame, each of the columns can be of a different data type; within a column, all elements must be of
the same data type. You can think of a data frame as being like a list, where each element corresponds to
a complete vector, and all elements are the same length.

ii. Vectors

1. We’ve already seen a vector when we ran the rnorm() command. Let’s run that again, but this time
assigning the result to a variable.

x <- rnorm(100)

2. Many commands in R take a vector as input.

sum(x)

max(x)

summary(x)

plot(x)

hist(x)

Don’t get too excited about the plotting yet; we will be making prettier plots soon!

3. There are many ways of creating vectors. The most common way is using the c() function, where c

stands for concatenation. Here we assign a vector of characters (character strings must be quoted).

colors <- c("red", "orange", "yellow", "green", "blue", "indigo", "violet")

4. The c() function can combine vectors.

colors <- c("infrared", colors, "ultraviolet")

# remember that "infrared" is a one-element vector

By assigning the result back to the colors variable, we are updating its value. The net effect is to
both prepend and append new colors to the original colors vector.

5. You can get the length of a vector using the length() function.
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length(colors)

6. You can access an individual element of a vector by its position (or “index”). In R, the first element
has an index of 1.

colors[7]

7. You can also change the elements of a vector using the same notation as you use to access them.

colors[7] <- "purple"

Tip: Appending an element is a slow operation because it actually creates a new vector. If you
do this a limited number of times, this is fine, but if you are doing this 1000s of times, it is more
efficient to create an empty vector of a pre-determined size, and then change the elements.
You can create a blank vector using the vector() function.
a.numeric.vector <- vector(mode="numeric", length=1000)

a.numeric.vector[50] <- 5

a.numeric.vector[750] <- 10

plot(a.numeric.vector)

8. You can access multiple elements of a vector by specifying a vector of element indices.

9. R has many built-in datasets for us to play with. You can view these datasets using the data()

function. Two examples of vector datasets are state.name and state.area.

10. We can get the last ten states (alphabetically) by using R’s convenient way of making a vector of
sequential numbers, with the “:” operator

indices <- 41:50

indices[1]

indices[2]

length(indices)

state.name[indices]

Exercise:

a. We’ve seen how to list the last 10 states (alphabetically). How would you list the first 10 states?

b. How would you list the first 10 and last 10 states (alphabetically)?

c. Can you generalize this so that it works for any arbitrary length vector?

11. We can test all the elements of a vector at once using logical expressions. Let’s use this to get a list
of small states. First, how do we determine what a small state is?

summary(state.area)

Next, figure out which states are in the bottom quartile.

cutoff <- 37317

state.area < cutoff

Note that this returns a vector of logical elements. We have seen that we can access vector elements
using their indices, but we can also access them using logical vectors.

small.states <- state.name[state.area < cutoff]

12. We can test for membership in a vector using the %in% operator. To see if a state is among the
smallest:
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"New York" %in% state.name[state.area < cutoff]

"Rhode Island" %in% state.name[state.area < cutoff]

13. You can also get the positions of elements that meet your criteria using the which() function.

which(state.area < cutoff)

state.name[which(state.area < cutoff)]

Techniques like this can be useful for removing outliers from your data.

14. Let’s get the area of Wyoming:

state.area[state.name == "Wyoming"]

Notes:

(a) The == is a test for equality. This is different from assignment.

(b) The indexing vector here is a logical vector.

15. While this works, it can be a little long-winded. Luckily, R lets us name every element of a vector
using the names() function.

names(state.area) <- state.name

16. And now we can access Wyoming directly:

state.area["Wyoming"]

17. Here the indexing vector we are using to access elements is a character vector.

state.area[c("Wyoming", "Alaska")]

18. Now we can see all the small states and their areas in one shot:

state.area[small.states]

19. Sadly, not all functions that fetch an element from a vector keep the associated name.

min(state.area)

But you can find the index at which the minimum occurs, and use that.

state.area[which.min(state.area)]

20. In addition to using the : notation to create vectors of sequential numbers, there are a handful of
useful functions for generating vectors with systematically created elements.

seq(1, 10) # same as 1:10

seq(1, 4, 0.5) # shows all numbers from 1 to 4, incrementing by 0.5 each time

Let’s look carefully at the help page for the seq() function.

?seq

21. The seq() function can take five different arguments, but not all of them make sense at the same
time. In particular, it would not make sense to give the from, to, by, and length arguments, since
you can figure out the length given from, to, and by. You can pass argments by name rather than
position; this is helpful for skipping arguments.

seq(0, 1, length.out = 10)

Tip: In scripts, it is often good form to use named arguments, even when not necessary, as it
makes your intent clearer.
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seq(from = 1, to = 4, by = 0.5)

seq(from = 0, to = 1, length.out = 10)

22. Take a look at the help again: note that all of the arguments have default values, which will be used
if you don’t specify them.

seq(to = 99)

23. Another commonly used function for making regular vectors is rep(). This repeats the values in the
argument vector as many times as specified. This can be used with character and logical vectors as
well as numeric.

rep(colors, 2)

rep(colors, times = 2) # same as above

rep(colors, each = 2)

rep(colors, each = 2, times = 2)

24. When using the length.out argument, you may not get a full cycle of repetition.

rep(colors, length.out = 10)

25. In many cases, R will implicitly “recycle” vector elements as needed to get operations on vectors to
make sense. When vector operations align, results are as you would expect:

x <- 0:9

y <- seq(from = 0, to = 90, by = 10)

x + y

Here, the first element of x has the first element of y added to it, the second element of x has the
second element of y added to it, etc. What happens when the vectors are not the same length?

(1:5) + y

26. Here the elements of the first vector were recycled (your linear algebra professor would be horrified).
When one vector is shorter than the other, the elements of that entire vector get recycled, starting
from the first element and getting repeated as often as necessary. Note that if this mechanism does
not use a complete cycle, you’ll get a warning.

(1:4) + y

27. Finally, note that using a single value (i.e., a scalar) is just a special case of recycling the same value
over and over.

y * 2

Exercise:

a. 0:10 / 10 yields the same result as seq(from = 0, to = 1, by = 0.1). Can you understand
why? Which do you think is more efficient?

b. Can you predict what this command does?

10 ^ (0:5)

28. R supports sorting, using the sort() and order() functions.

sort(state.area) # sort the areas of the states from smallest to largest

order(state.area) # return a vector of the positions of the sorted elements

state.name[order(state.area)] # sort the state names by state size

state.name[order(state.area, decreasing = TRUE)] # sort the state names by state size
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29. We can also randomly sample elements from a vector, using sample().

sample(state.name, 4) # randomly picks four states

sample(state.name) # randomly permute the entire vector of state names

sample(state.name, replace = TRUE) # selection with replacement

This is frequently used in bootstrapping techniques.

30. Other miscellaneous useful commands on vectors include

rev(x) # reverses the vector

sum(x) # sums all the elements in a numeric or logical vector

cumsum(x) # returns a vector of cumulative sums (or a running total)

diff(x) # returns a vector of differences between adjacent elements

max(x) # returns the largest element

min(x) # returns the smallest element

range(x) # returns a vector of the smallest and largest elements

mean(x) # returns the arithmetic mean

Summary: Vector elements are accessed using indexing vectors, which can be numeric, character or
logical vectors.

Summary: List of logical expression functions:
< > <= >= != == %in%

Summary: Methods of generating regular vectors:
1. Numeric vector, from scratch, shortcut:

from:to

2. Numeric vector, from scratch:
seq(from, to, by, length.out, along.with)

3. Any type of vector, derived from an existing one (x):
rep(x, times, length.out, each)

iii. Factors

Factors are similar to vectors, but they have another tier of information. A factor keeps track of all the
distinct values in that vector, and notes the positions in the vector where each distinct value can be found.
Factors are R’s preferred way of storing categorical data.

The set of distinct values are called levels. To see (and set) the levels of a factor, you can use the levels()

function, which will return the levels as a vector.

1. R has an example factor built in:

state.division

levels(state.division)

2. To get a hint about how R stores factors (or any other object), we can use the str() function to view
the structure of that object. You can also use the class() function to learn the class of an object,
without having to see all the details.

str(state.division)

class(state.division)
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Note the list of integers corresponds to the level at each position. While factors may behave like
character vectors in many ways, they are much more efficient because they are internally represented
as integers and computers are good at working with integers.

3. You can convert a vector to a factor using the factor() function. Let’s wish for some ponies.

pony.colors <- sample(colors, size = 500, replace = TRUE)

str(pony.colors)

Note that we are storing each color as a character string. This is not ideal. Let’s convert this vector
to a factor.

pony.colors.f <- factor(pony.colors)

str(pony.colors.f)

4. You can plot a factor to see how frequently each level appears.

plot(pony.colors.f)

The levels are plotted in the order they are returned by levels(). But you can control the order of
the levels when you create the factor.

pony.colors.f <- factor(pony.colors, levels = colors)

str(pony.colors.f)

plot(pony.colors.f)

5. You can make a factor from a factor, reordering its levels as you go.

plot(state.division)

state.division <- factor(state.division, levels = sort(levels(state.division)))

plot(state.division)

6. You can rename the levels in a factor by assignment to its levels(). This only changes the labels, not
the underlying integer representation. In this case, the labels we have are quite long; let’s abbreviate
them.

levels(state.division)

levels(state.division) <- c("ENC", "ESC", "MA", "MT", "NE", "PAC", "SA", "WNC", "WSC")

plot(state.division)

7. In most cases, you can treat a factor as a character vector, and R will do the appropriate conversions.
Here we list the states in the North East, and then compare the sizes of various groups of states.

state.name[state.division == "NE"]

mean(state.area[state.division == "NE"]) / mean(state.area[state.division == "WSC"])

t.test(state.area[state.division == "SA"], state.area[state.division == "MT"])

iv. Matrices

Multi-dimensional structures in R, where all the elements are of the same data type, are called arrays.
Arrays have three dimensions: number of rows, number of columns and number of layers. Matrices are a
special type of array using only two of those dimensions (rows and columns) and can be thought of as
tables.

1. Let’s use one of R’s built-in datasets, the USPersonalExpenditure dataset, which describes how
much Americans spent in five categories from 1940-1960.
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?USPersonalExpenditure

USPersonalExpenditure

2. Notice that the rows and columns of the matrix are named, using the categories and years as row
names and column names, respectively. You can access (and set) the row names and column names
using the rownames() and colnames() functions. There is a third function, dim(), which tells you
the number of rows and columns making up your matrix.

rownames(USPersonalExpenditure)

colnames(USPersonalExpenditure)

dim(USPersonalExpenditure)

These functions return vectors, which can be accessed with all the usual access methods.

3. Accessing (and assigning) elements of a matrix is analogous to accessing (and assigning) elements of
a vector, except that matrices need two indexing vectors, one for rows and one for columns.

4. Let’s say we wanted to see the Food and Tobacco expenditure for 1950:

USPersonalExpenditure[1, 3]

USPersonalExpenditure["Food and Tobacco", "1950"]

USPersonalExpenditure[1, "1950"]

5. To get this expenditure for several years, we pass a vector for the column index.

USPersonalExpenditure[1, c(5, 3, 1)]

USPersonalExpenditure["Food and Tobacco", c("1960", "1950", "1940")]

6. Omitting a row or column index implies that all of the elements are wanted along that dimension.

USPersonalExpenditure[1, ]

USPersonalExpenditure["Food and Tobacco", ]

USPersonalExpenditure["Food and Tobacco", , drop = FALSE]

USPersonalExpenditure[ , c("1940","1950")]

USPersonalExpenditure[1:3, c("1940","1950")]

7. Observe that if your result is one-dimensional, it is by default returned as a vector. All the vector
operations you learned can be used on this output. If you don’t want this behavior, you can use the
drop=FALSE option, as was shown in the third example above.

sum(USPersonalExpenditure[ , "1940"])

8. If you access an element of a matrix using only one index, R will treat the elements of the matrix as
a vector of stacked columns.

USPersonalExpenditure[1]

USPersonalExpenditure[2]

USPersonalExpenditure[7]

9. This is usually not the clearest way to access elements, but can be useful when you want to work
with all of the elements.

length(USPersonalExpenditure)

sum(USPersonalExpenditure)

10. There are a few ways to make a new matrix. The matrix() function takes as arguments a vector of all
the elements, and then some information about how many rows and columns there are. By default,
the matrix is filled in column order, but you can change this behaviour with the by.rows=TRUE

option.
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game1 <- matrix(c("X","","O","","X","O","","",""), ncol = 3)

game2 <- matrix(c("X","","O","","X","O","","",""), ncol = 3, byrow = TRUE)

Notes:

a. The elements of this matrix are characters. As with vectors, all elements in a matrix must be
of the same datatype.

b. In this matrix, the rows and columns are not named, and can only be accessed using numeric
indices.

11. Assignment of values is just like for vectors, except using two dimensions.

game1[3, 3] <- "X" # I win!!!!!

12. When making a fresh game, we can set the size in advance, and fill it in piecemeal. This is much
more efficient than extending the matrix each time a new row or column is added.

new.game <- matrix(data = "", ncol = 3, nrow = 3)

13. We can assemble a matrix by combining vectors or matrices. They can be stacked by row or col-
umn, using the rbind() or cbind() functions, respectively. Here, we build a chess board from the
component pieces.

pieces <- c("rook", "knight", "bishop", "queen", "king", "bishop", "knight", "rook")

pawns <- rep("pawn", 8)

board <- rbind(pieces, pawns, matrix("", nrow = 4, ncol = 8), pawns, pieces)

rownames(board) <- 8:1

colnames(board) <- letters[1:8]

letters is a very handy built-in vector of all 26 lowercase letters. See the help for constants for a
few more handy built-ins.

14. Remember all of the elements in a matrix must be of the same data type. If you assign one element
of a different data type, R will convert (or coerce) elements as necessary.

USPersonalExpenditure["Personal Care", "1955"] <- "Unknown"

USPersonalExpenditure

All the numbers have been converted to characters. How should we have done this to avoid this
coercion?

rm(USPersonalExpenditure) # revert to built-in dataset

15. R coerces elements up the data type chain, only far enough to satisfy the rule that all elements
remain the same type. If you add an integer to a matrix of logicals, you’ll get a matrix of integers,
not characters, as in the example above.

NULL < raw < logical < integer < double < complex < character < list < expression

The same coercion strategy applies to vectors.

The next section introduces a data structure that allows mixed types.

v. Lists

Lists are similar to vectors, but with some differences. Lists can hold data structures of different types,
and of different sizes. Each component in a list can be (optionally, but commonly) separately named (a list
in R is analogous to a hash or associative array in most other programming languages). In fact, one list
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can be a member of another list, allowing for deeply nested and arbitrarily complex data structures to be
modeled.

1. The results of many high-level analyses in R are packaged as lists. Let’s use R to fit a linear model
to some data.

(edu.spend <- unname(USPersonalExpenditure["Private Education", ]))

(edu.yr <- seq(from = 0, to = 20, by = 5))

plot(edu.yr, edu.spend)

my.model <- lm(edu.spend ~ edu.yr)

my.model

summary(my.model)

abline(my.model)

plot(my.model)

The lm() function fits data to a linear model (i.e., performs a linear regression), and packages up
all of the results into an object we have named my.model. The my.model object is of class lm (linear
model), which is a special kind of list. You may have to rm() USPersonalExpediture from your
environment before running the above commands, if your object is still coerced into character strings
from the previous section.

2. Remember that we can look into any object using the str() function. Let’s do that now with our
linear model. Brace yourself!

str(my.model)

Take a moment to get a sense of what is packaged in the linear model object (but don’t stress over
the details).

Now look carefully at the very first line of the output and note that this object is a “List of 12”.
This object has 12 components, and many of those have sub-components (an element of a list can be
another list).

We’ll need to learn about lists so we can access the subcomponents of the model object; for example,
you’d probably want to extract the slope and intercept of the best-fit line from this object. Let’s
start with the basics. . .

3. Lists can be created using the list() function. When using the list() function, you can optionally
give names to the components (component names are called tags).

ad.mouse.colony <- list("9.1", FALSE)

ad.mouse.colony <- list(room = "9.1", bsl3 = FALSE)

Note that we have different data types in the same list (character, and logical). Note also the difference
between the first and second attempt to model a mouse colony. In the first case, you need to know
what the position of each component is; in the second, each component is named (tagged) with the
tag we provided at creation.

4. We can add a component to an existing list

ad.mouse.colony$conditions <- list(bedding = "straw", light_hrs = 12)

ad.mouse.colony$count <- c(male = 10, female = 0)

ad.mouse.colony[["variants"]] <- c("APP695swe", "PS1-dE9")

Note that we have used two different notations to refer to components of a list.

5. There are several ways to refer to the components of a list; the differences can be subtle, but important.
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The most straightforward way to refer to a single component is using the [[ notation. You can always
provide an integer to access the component by position, or you can provide a character string if the
component is tagged.

For tagged components where the tag is a literal character string, you can use the $ notation. This
is less flexible, but looks clearer. Use this when you can.

6. Just as for vectors, to get the names of tagged components, use names().

names(ad.mouse.colony)

7. If you want to access multiple components, you can use the [ notation, which takes the usual indexing
vector. Note that this will always return a list (this has to be so, because the components returned
could be of different datatypes).

Exercise:

a. What does this return?

ad.mouse.colony[[3]]

b. How about this?

ad.mouse.colony[[3]]$bedding

c. Why does this NOT work?

ad.mouse.colony[3]$bedding

d. How would you add a new element (say, temp = 36.5) to the conditions list?

8. To remove a component, assign it the value NULL.

ad.mouse.colony$bsl3 <- NULL

Note that this changes the index positions of all subsequent components (yet another reason to use
tags!)

9. All objects can have arbitrary additional attributes, which can be used to store metadata about the
object, which are stored as a named list (with unique names). Attributes can be accessed individually
with attr() or all at once (as a list) with attributes().

x <- c(0, 1, 1, 2, 3, 5, 8, 13, 21)

attr(x, "description") <- "Fibonacci sequence"

attr(x, "description")

attributes(x)

str(attributes(x))

10. Remember our linear model?

Exercise:

a. Can you extract the slope and intercept of the best-fit line?

b. Can you extract the value of R2 reported by the summary() function we used? Hint: save the
result of this function, and look into its structure.
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vi. Data frames

Data frames are two-dimensional data structures like matrices, but, unlike matrices, they can contain
multiple different data types. You can think of a data frame as a list of vectors, where all the vector
lengths are the same. Data frames are commonly used to represent tabular data.

1. When we were learning about vectors, we used several parallel vectors, each with length 50 to represent
information about US states. The collection of vectors really belongs together, and a data frame is
the tool for doing this.

state.db <- data.frame(state.name, state.abb, state.area, state.center,

stringsAsFactors = FALSE)

state.db

The data.frame() function combines the four data sets into a single data frame. Note that the first
three data sets are vectors (two character, one numeric), but the last data set is a list with two
components.

Note the stringsAsFactors = FALSE argument. Some of the vectors that we are using are character
vectors, but will be automatically converted to factors if this option is not set. Since we will want to
work with our character data as vectors, not as factors, we want to set this argument to FALSE.

2. In addition to the str() function, you can glean useful information about a data frame (and other
data structures) using the summary() and head() functions.

summary(state.db)

head(state.db)

3. Data frames have a split personality. They behave both like a tagged list of vectors, and like a matrix!
This gives you many options for accessing elements. Fortunately, you know them all already!

When accessing a single column, the list notation is preferred.

state.db$state.abb

state.db[[ "state.abb" ]]

state.db[[ 2 ]]

When accessing multiple columns or a subset of rows, the matrix notation is used (rows and columns
are given indexing vectors).

state.db[ , 1:2]

state.db[41:50, 1:2]

state.db[c(50, 1), c("state.abb", "x", "y")]

state.db[order(state.db$state.area)[1:5], ]

state.db[order(state.db$state.area), ][1:5, ]

The last two examples produce the same output; which is more efficient?

4. As with matrices, the rows can be given names as well. This makes picking out specific rows less
error-prone. Column names are accessed with the names() or colnames() functions.

rownames(state.db) <- state.abb

state.db[c("NY", "NJ", "CT", "RI"), c("x", "y")]

names(state.db) <- c("name", "abb", "area", "long", "lat")

Note that if you only fetch data from one column, you’ll get a vector back. If you want a one-column
data frame, use the drop = FALSE option.
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5. You can add a new column the same way you would add one to a list.

state.db$division <- state.division # Remember, this is a factor

state.db$z.size <- (state.db$area - mean(state.db$area))/sd(state.db$area)

state.db[ , "z.size", drop = FALSE]

6. Remember that you can pass logical vectors as indices.

state.db[state.db$area < median(state.db$area), "name"]

state.db[state.db$area < median(state.db$area), "name", drop = FALSE]

coastal <- state.db[ state.db$division %in%

c("New England", "Middle Atlantic", "South Atlantic", "Pacific"), ]

7. Another way to select data from a data frame is using the subset() function. You can choose rows
based on a logical expression and can choose columns with the select option. With this function,
we only have to type the dataset name once.

subset(state.db, area < median(area), select = name)

coastal <- subset(state.db, division %in%

c("New England", "Middle Atlantic", "South Atlantic", "Pacific") )

The logical condition is optional, and you can specify columns to omit instead of columns to include.

subset(state.db, select = c(name, abb))

subset(state.db, select = -c(long, lat))

8. Many tools in R work naturally with data frames. For example, visualizing the size distribution of
state within each division could not be easier once the data is in a well-designed data frame.

plot(area ~ division, data = state.db)

plot(log(area) ~ division, data = state.db)

plot(lat ~ long, data = state.db)

text(lat ~ long, data = state.db, rownames(state.db))

Here we are using R’s function notation. Read the first argument in the first plot() example as “area
as a function of division”.

9. Exercise:

a. Can you add Puerto Rico to our data frame? [abb = “PR”, area = 3515 sq mi, long = -66.1,
lat = 18.45, division = “South Atlantic”]

b. How about Greenland? [abb = “GL”, area = 836330 sq mi, long = -51.73, lat = 64.17, division
= “Arctic Circle”]

10. In most cases in the lab, you won’t be typing the data in by hand but rather importing it. R provides
tools for importing a variety of text file formats. If you receive data in Excel format, you’ll want to
save it as tab-delimited or CSV (comma separated values) text. The read.delim() or read.csv()

functions can then be used to import the data into a data frame. Of course, you should also tell your
colleagues that R is the preferred tool for data wrangling!

We have prepared an Excel file for you to import.

a. Go to http://chagall.med.cornell.edu/Rcourse/ and download the Ablation.xlsx file into
your project folder.

b. Open the file using Microsoft Excel and save it in CSV format. You can quit Excel now!
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c. Return to RStudio.

d. Use the Files tab (bottom right) to take a look at the .csv file.

e. Import the data into a data frame:

ablation <- read.csv("Ablation.csv", header = TRUE, stringsAsFactors = TRUE)

Note that we explicitly asked that strings be converted to factors. In cases where you are
importing string data, you would want to set this to FALSE, and after import, convert appropriate
columns to factors.

f. Rename the SCORE column to be consistent with the other column names.

names(ablation)[names(ablation) == "SCORE"] <- "Score"

Note that we did not use names(ablation)[6] <- "Score". Why do you think that is?

There is another more general import function, read.table(), that gives you exquisite control over
how to import your data. One of the defaults of this function is header = FALSE. For this reason, we
suggest that you always explicitly use the header option (you don’t want to accidentally miss your
first data point).

11. If your uninitiated colleagues insist on an Excel-compatible format, you can also export a data frame
using write.csv().

write.table(ablation, file = "ablation.txt",

quote = FALSE, col.names = NA,

sep = "\t")

write.table(ablation, file = "ablation.txt",

quote = FALSE, row.names = FALSE,

sep = "\t")
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V Miscellaneous

i. User-defined functions

Although R has a wide array of in-built functions, as well as many other functions that can be accessed
via third party packages (more on that later), we can also create our own functions, using function(). We
define not only the arguments, or inputs, to the function, but also what it does, and what it returns.

1. Within the body of a function, all of the input arguments become variables that you can use, including
passing them to other functions.

mySummary <- function(x) {

my.mean <- mean(x)

my.sd <- sd(x)

list(mean = my.mean, sd = my.sd)

}

mySummary(rnorm(100))

Here, our function, called mySummary, takes a single argument called x. This function assumes that
x is a numeric vector, and computes the mean and standard deviation of that vector. The function
returns a list with two tagged components; the return value of a function is the last expression
evaluated in the function body. The code executed by our function is enclosed in curly braces {}.

2. We can also create functions which can have multiple arguments, and default values for arguments.

raiseNumber <- function(x, power = 1) {

x ^ power

}

raiseNumber(10)

raiseNumber(10, 3)

ii. Loops

Computers are very good at dealing with repetitive tasks. Often we would like to perform a task for some
number of objects, or a certain number of times. While we could just repeat the same command over and
over again, changing one parameter each time, a better and less error-prone way is to write a loop.

Here we will look at using a ‘for‘ loop, which takes some number of elements and runs a series of commands
for each element. The ‘for‘ loop starts by assigning the first element to a user-defined variable, and executing
the statements in the body of the code. Then, if there are more elements, it goes back to step 1, assigns
the next element to the variable, and so on, until there are no more elements, at which point it exits the
‘for‘ loop and goes on to the next statement. Note that we pre-allocate the size of the vector that we store
our results in, and fill in as we go.

num_iterations <- 100

my_means <- numeric(length = num_iterations)

for (i in 1:num_iterations) {

x <- rnorm(10000)

my_means[i] <- mean(x)

}

hist(my_means)
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VI CRAN and Libraries

One of the major advantages of using R for data analysis is the rich and active community that surrounds
it. There is a rich ecosystem of extensions (also known as libraries or packages) to the base R system. Some
of these provide general functionality while others address very specific tasks.

The main hub for this ecosystem is known as CRAN (Comprehensive R Archive Network). CRAN can be
accessed from http://cran.r-project.org/. This is also where you go to download the R software.

Follow the Packages link to browse the 5000+ packages currently available.

Because R is a not a very specific search term, often when doing a web search, the term CRAN is used.

In the next section, we will learn how to use the ggplot2 package for preparing publication-quality figures.
Here we will download and install the tidyverse package, which includes ggplot2, as well as dplyr and tidyr
which we will be using shortly. This couldn’t be easier, because R knows all about CRAN.

install.packages("tidyverse") # Library name is given as a string

If this is the first time a package is being installed on your computer, R may ask you to select a CRAN
mirror. Pick something geographically close by. Note that you only have to install a package once.

Depending on how your computer (and R installation) is set up, you may receive a message indicating that
the central location for packages is not writable; in this case R will ask if you want to use a personalized
collection of packages stored in your home directory.

Installing a package does not make it ready for use in your current R session. To do this, use the library()
function.

library(tidyverse) # Library name is an object (not a string)

You need to do this in every session or script that will use functions from this library.
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VII Plotting

Although R has some basic plotting functionality which we have seen hints of, the ggplot2 package is
more comprehensive and consistent. We’ll use ggplot2 for plotting for the rest of this workshop.

ggplot2 is written by Hadley Wickham (http://had.co.nz/). He maintains a number of other libraries;
they are of excellent quality, and are very well documented. However, they are updated frequently, so make
sure that you are reading the current documentation. For ggplot2, this can be found at. . .

http://docs.ggplot2.org/current/

In this workshop, we will also be using his tidyr and dplyr packages.

ggplot2 relies entirely on data frames for input.

1. Let’s make our first ggplot with the ablation data that we imported earlier.

ggplot(ablation, aes(x = Time, y = Score)) + geom_point()

At a minimum, the two things that you need to give ggplot are:

a. The dataset (which must be a data frame), and the variable(s) you want to plot

b. The type of plot you want to make.

2. ggplot gives you exquisite control over plotting parameters. Here, we’ll change the color and size of
the points.

ggplot(ablation, aes(x = Time, y = Score)) + geom_point(color = "red", size = 4)

Aesthetics are used to bind plotting parameters to your data.

ggplot(ablation, aes(x = Time, y = Score)) +

geom_point(aes(color = Experiment), size = 4)

ggplot(ablation, aes(x = Time, y = Score)) +

geom_point(aes(color = Experiment, shape = CellType), size = 4)

3. When using ggplot, layers are added to a ggplot object. You can add as many layers as you like.

ggplot(ablation, aes(x = Time, y = Score)) +

geom_point(aes(color = Experiment), size = 4) +

geom_text(aes(label = CellType), hjust = 0, size = 3)

It is sometimes useful to save off the base ggplot object and add layers in separate commands. The
plot is only rendered when R “prints” the object. This is useful for several reasons:

a. We don’t need to create one big huge command to create a plot, we can create it piecemeal.

b. The plot will not get rendered until it has received all of its information, and therefore allows
ggplot2 to be more intelligent than R’s built-in plotting commands when deciding how large a
plot should be, what the best scale is, etc.

p <- ggplot(ablation, aes(x = Time, y = Score))

p <- p + geom_point(aes(color = Experiment, shape = Measurement), size = 4)

p <- p + geom_line(aes(group = interaction(Experiment, Measurement, CellType),

color = Experiment,

linetype = CellType))

print(p) # plot gets rendered now
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Sourcing a file will not automatically generate output, so here we have to explicitly ask for the plot
to be printed.

Here we’ve added a layer that plots lines. We want a separate line for each unique combination of
Experiment, Measurement, and CellType. The interaction() function takes a set of factors, and
computes a composite factor. Try running. . .

interaction(ablation$Experiment, ablation$Measurement, ablation$CellType)

. . . to see what this does. This composite factor is passed to the group aesthetic of geom_line() to
inform ggplot which data values go together.

We have also added a new binding to geom_point(). The shape of each point is determined by the
corresponding Measurement. Note that ggplot prefers six or fewer distinct shapes (i.e., there are no
more than six levels in the corresponding factor). You can, however, use more using a command
like. . .

scale_shape_manual(values = 1:11)

Here we specify the shapes we want to use, as well as jittering the points slightly so they no longer
sit directly on top of one another.

p <- ggplot(ablation, aes(x = Time, y = Score))

p + geom_point(aes(color = Experiment, shape = Measurement),

size = 4, position = position_dodge(0.5)) +

scale_shape_manual(values = c(1,16))

We’ll show you how to draw a plot listing all the possible shapes at the end of this section.

4. In the above example, we specified that the color of both points and lines should be determined by the
Experiment. It is therefore tidier to specify this binding once in the ggplot aesthetic. Any bindings
defined there are inherited by all layers (but can be overridden by any individual layer’s aesthetic).

p <- ggplot(ablation, aes(x = Time, y = Score, color = Experiment))

p <- p + geom_point(aes(shape = Measurement), size = 4)

p <- p + geom_line(aes(group = interaction(Experiment, Measurement, CellType),

linetype = CellType))

print(p)

5. Some layers don’t plot data, but affect the plot in other ways. For example, there are layers that
control plot labels and plot theme (there are eight themes built-in to ggplot2 and many more available
at https://github.com/jrnold/ggthemes). The labs() function also modifies legend labels.

( p <- p + labs(title = "Ablation", x = "Time (minutes)", y = "% Saturation") )

( p <- p + theme_bw() + theme(plot.title = element_text(h = 0.5)))

6. ggplot gives you control over the scales of your plot. There is one scale for each binding. In the plot
we just made, there are five scales that we can manipulate: the x and y axes and the three legends.

Let’s change our x-axis to include the 5 minute timepoint. This is achieved with yet another layer.

p + scale_x_continuous(breaks = c(0, 5, 10, 20, 30))

p + scale_x_continuous(breaks = unique(ablation$Time))

Tip: In the second example above, we have computed the breaks from the data, rather than
listing them individually. This makes the code we are writing usable even when the data changes.
This is an essential strategy for reproducibly analyzing data at scale.

7. We can also manipulate legends with scale layers.
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p <- p + scale_shape_manual(values = c(1,16), labels = c("LDLR", "TfR")) +

scale_linetype_discrete(name = "Cell type") +

scale_color_manual(values = c("blue", "red", "green"))

Here we provide the labels for the Measurement scale (remember that we used an aesthetic to bind
shape to Measurement). Note that ggplot will always order the labels according to the levels of the
underlying factor, so the labels should be provided in that order. If you want to change the order in
which the legend elements are displayed, change the underlying factor.

We have also changed the title of the CellType legend (the linetype binding) to be two words and
used a different color palette (for the binding to Experiment).

8. You can use built-in color palettes from ColorBrewer (http://colorbrewer2.org). To see all avail-
able palettes:

library(RColorBrewer)

display.brewer.all()

and to use a ColorBrewer palette in your plot:

scale_color_brewer(palette = "Set1")

9. Note the general form of the scale layer functions:

scale_aestype_colortype

where the aestype is the bound aesthetic, and the colortype is the type of color associated with that
binding.

Common values for the aestype and colortype include:

Aestype

colour Color of lines and points
fill Color of area fills (e.g. bar graph)

linetype Solid/dashed/dotted lines
shape Shape of points

size Size of points
alpha Opacity

x,y x and y axes

Colortype

hue Equally-spaced colors from the color wheel
manual Manually-specified values (e.g., colors, point shapes, line types)

gradient Color gradients
grey Shades of grey

discrete Discrete values (e.g., colors, point shapes, line types, point sizes)
continuous Continuous values (e.g., alpha, colors, point sizes)

Table 1: Scale layer function components.

10. This plot is probably showing too much data at once. One approach to resolve this would be to make
separate plots for the LDLR and TfR measurements. You can make multiple plots at once using
facets. Here are a few options.

p + facet_grid(Measurement ~ .)

p + facet_grid(. ~ Measurement)
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p + facet_grid(Experiment ~ Measurement)

p + facet_grid(Measurement ~ Experiment)

In these plots, you can remove the color and shape legends entirely (an option that can be specified
in each of the respective legend layers). . .

p + facet_grid(Measurement ~ Experiment) +

scale_color_discrete(guide = "none") + scale_shape_discrete(guide = "none")

. . . or you may no longer want to bind the Measurement and Experiment variables to shape and color
at all.

Tip: The facet wrap() function in ggplot can be used to wrap a 1D ribbon of plots into a 2D
layout. You can also use the gridExtra package to place independently generated plots on the
same page.

11. When plotting many points, controlling opacity can be useful. Let’s model an ant-infested park.
(To create a reproducible data set, you can set the seed for the random number generator with the
set.seed() function).

trees <- data.frame(x = rnorm(100), y = rnorm(100),

size = rnorm(100, mean = 5, sd = 2))

ants <- data.frame(a = rnorm(10000, sd = 0.4, mean = 1),

b = rnorm(10000, sd = 0.2, mean = -1))

p1 <- ggplot() +

geom_point(data = ants, aes(x = a, y = b),

color = "brown", size = 2, alpha = 0.01) +

geom_point(data = trees, aes(x = x, y = y, size = size),

color = "green", shape = 8)

print(p1)

Note that here we are plotting points from two different data frames, so we don’t provide a default
dataset or default bindings to x or y in the ggplot() function. These can always be set (or overridden)
in individual layers.

Exercise:

a. Compare the result without specifying alpha.

12. ggplot can do statistical analyses on the fly. We won’t cover the details here, but here’s an example
to whet your appetite:

p2 <- ggplot() +

stat_density2d(data = ants, aes(x = a, y = b, fill= ..level.. ),

alpha = 0.5, geom = "polygon") +

geom_density2d(data = trees, aes(x = x, y = y)) +

geom_point(data = trees, aes(x = x, y = y, size = size),

color = "green", shape = 8) +

scale_fill_gradient(low = "white", high = "brown") +

scale_size_continuous(guide = "none")

# or scale_size_continuous(name = "Tree size")

print(p2)

Note the use of the binding to the ..level.. variable. This binds to a statistic (in this case, the 2D
density of points) computed by the stat_density2d() layer (computed variables are identified by
the appended and prepended “..”).
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13. You can ask R to produce your plots as PDF files rather than display them on the screen.

pdf(file = "figures.pdf", paper = "letter")

print(p)

print(p1)

print(p2)

dev.off()

Whenever a PDF device is open, all plotting (with ggplot or otherwise) will be to the PDF file, not
to the RStudio plot tab. So don’t forget that dev.off() command.

Note that you can also use RStudio to export individual plots as PDFs or PNGs from the Plot tab.

14. As promised above, here we show some code that prints a reference of all the 26 shapes that are
available. Note that several shapes can also have a fill aesthetic.

i <- 0:25; x <- i %/% 6; y <- i %% 6

df <- data.frame(name = i, row = x, column = y)

ggplot(df, aes(x = row, y = column)) +

geom_point(shape = 0:25, fill = "yellow", size = 4) +

geom_text(label = i, vjust = 2) +

scale_y_reverse() +

theme(axis.title.x=element_blank(), axis.text.x=element_blank(),

axis.ticks.x = element_blank(),

axis.title.y=element_blank(), axis.text.y=element_blank())
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VIII Data wrangling

You may have noticed that the format of the ablation data frame is a bit peculiar. The Excel sheet you
imported for the plotting exercise is probably not what you are used to getting from your colleagues, or
working with yourself. It is, however, in the canonical format for storing and manipulating data that you
should be using.

The hallmark of this canonical (tidy) format is that there is only one (set of) independently observed
value(s) in each row. All of the other columns are identifying values. They explain what exactly was
measured. This is also known as metadata in some circles.

More specifically, a tidy dataset is defined as one where:

• Each variable forms a column.

• Each observation forms a row.

When your data is in this format, it is straightfoward to subset, transform, and aggregate it by any com-
bination of factors of the identifying variables. That is why, for example, the ggplot package essentially
requires that your data is in tidy format.

The tidyverse that Hadley Wickham has been instrumental in creating has this format at its core, and his
tidyr package includes functions to help coerce your data into this format. This section will also introduce
another tidyverse package called dplyr, which is used to perform more complex manipulations on your
data.

i. Going long

1. If you are given data in non-canonical format, you can use the gather() function to fix it. This will
convert a data frame with several measurement columns (i.e., “fat” or “wide”) into a “skinny” or
“long” data frame which has one row for every observed (measured) value. The gather() function
takes multiple columns that all have the same measurement type, and collapses them into key-value
pairs, duplicating all other columns as needed.

Let’s start with a “fat” data frame that contains data about mouse weights.

set.seed(1)

mouse.weights.sim <- data.frame(

time = seq(as.Date("2017/1/1"), by = "month", length.out = 12),

mickey = rnorm(12, 20, 1),

minnie = rnorm(12, 20, 2),

mighty = rnorm(12, 20, 4)

)

This dataset consists of only one type of measurement - mouse weights - where each column in this
dataset represents the weights of a given mouse over a year. The columns ‘mickey’, ‘minnie’ and
‘mighty’ are the names of each mouse, and each of the three columns contain weight data for that
respective mouse. The tidy version of this data would have all the weight measurements in one column
(the “values”) with another column detailing which mouse (or column) that measurement came from
(the “keys”).

mouse.weights <- gather(data = mouse.weights.sim,

key = mouse, value = weight, mickey, minnie, mighty)

mouse.weights <- gather(data = mouse.weights.sim, key = mouse, value = weight, -time)
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mouse.weights <- gather(data = mouse.weights.sim,

key = mouse, value = weight, mickey:mighty)

After gathering our data, each variable forms a column. Our three variables are time, mouse, and
weight. Each row is now an observation. Before tidying our data, each row represented three observa-
tions. Note that the arguments to the key and value options become the names of the new columns.
Now that the data have been tidied, it is trivial to use as input to ggplot.

ggplot(mouse.weights, aes(x = mouse, y = weight)) +

geom_boxplot(aes(fill = mouse))

ggplot(mouse.weights, aes(x = time, y = weight)) +

geom_boxplot(aes(group = time))

ggplot(mouse.weights, aes(x = time, y = weight)) +

geom_boxplot(aes(group = time)) + geom_point(aes(color = mouse))

ggplot(mouse.weights, aes(x = time, y = weight)) +

geom_point(aes(color = mouse)) + geom_line(aes(group = mouse, color = mouse))

2. Although you can only use the gather() function to tidy data structures such as data frames, you
can always coerce other data structures into a format that can be used. For example, the USPerson-
alExpenditure dataset is a matrix, that we can coerce into a data frame, which can then be tidied as
above.

uspe.df <- as.data.frame(USPersonalExpenditure)

uspe.df$Category <- rownames(USPersonalExpenditure)

uspe <- gather(uspe.df, Year, Amount, -Category)

Once tidied, the data can again be readily plotted with ggplot. Here we’ll use stacked bar charts,
showing the expenditure per year, colored by Category.

ggplot(uspe, aes(x = Year, y = Amount)) +

geom_bar(stat = "identity", aes(fill = Category))

ggplot(uspe, aes(x = Year, y = Amount)) +

geom_bar(stat = "identity", aes(fill = Category)) +

theme(legend.justification = c(0,1), legend.position = c(0,1))

ggplot(uspe, aes(x = Year, y = Amount)) +

geom_bar(stat = "identity", position = "dodge", aes(fill = Category)) +

theme(legend.justification = c(0,1), legend.position = c(0,1))

By default, geom_bar() is set up to plot frequencies of categorical observations. Since we are plotting
numerical values, we need to use the stat = "identity" option. In the second example, we have
relocated the legend, and in the third, we demonstrated how we can draw the bars to be side-by-side,
rather than stacked.

ii. Going wide

1. The complement of the gather() function is the spread() function.

spread(data = mouse.weights, key = mouse, value = weight)

Similarly, we can reshape our ablation dataset into a dataframe where there is one row per time point
and one column per CellType.

spread(ablation, key = CellType, value = Score)
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Note that all of the experimentally measured values in this table come from the original Score

column; this is indicated by the value option in the above command.

2. It is also possible to have columns that are combinations of identifiers, but you will need to include
an extra step of manually combining those columns first. Say we wanted a wide table where each of
the measurement columns showed the value for a specific combination of Experiment and CellType.
We would use another function from the tidyr package, unite().

abl.united <- unite(ablation, ExptCell, Experiment, CellType, sep = ".")

spread(abl.united, ExptCell, Score)

Here, ExptCell is the new column that we are defining, as a combination of Experiment and CellType,
where the names of the identifiers will be separated by a period.

3. Finally, the opposite of the unite() function is separate().

separate(abl.united, ExptCell, c("Expt", "Cell"), sep = "\\.")

Note that here, if the separator is a character string, it is interpreted as a regular expression, so we
have to escape out the period character. The separate() function can be used to split any single
column which captures multiple variables.

iii. Joining dataframes

1. It is usually a good idea to keep all of your data from a particular study or project in a very small
number of canonical “skinny” data frames. Consider the ablation data we’ve been using; when new
experiments are performed, you can add new rows to the ablation data frame with the rbind

function. If the data for the new experiment is given to you in “fat” format (say via a new Excel
workbook), you may need to gather() the new data first, and then rbind() it.

2. Sometimes, you will want to add new columns before doing this. For example, if all of the data thus
far was collected by one tech, you probably did not bother to store that metadata. However, if, after
some early success, your PI assigns another post-doc to the project, you may want to create a new
data frame with this information and store it in the project environment.

experiment.log <- data.frame(Experiment = c("E1909", "E1915", "E1921"),

Tech = c("Goneril", "Regan", "Cordelia"),

stringsAsFactors = TRUE)

str(experiment.log)

experiment.log

When looking for technician-specific bias, you will need to merge the technician data with your main
data. The dplyr package includes a number of functions to help with this.

inner_join(ablation, experiment.log)

The inner_join() function merges two data frames based on common column values. By default, it
looks for common column names, but these can be specified explicitly. The inner_join() function
keeps only rows which have elements common to both data frames (it is similar to a database table
inner join). You can force a left or right (or full) database-style join by using the left_join(),
right_join() and full_join() functions, respectively.

The merged data frame contains redundant information; i.e., if you know the Experiment, you know
the Tech (we say the data is “denormalized”). While the merged data frame may be convenient when
investigating “tech effects”, you probably don’t want to store this data frame permanently. This
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becomes more important at scale, when the cost of storing the redundant information becomes a
limiting factor (usually in terms of the memory needed by R).

Tip: Use * join()! Don’t depend on vectors being aligned unless you are absolutely, positively
sure they are, and * join() is not an option. Such assumptions are a very, very common source
of errors in data analysis (not just in R – think about what you do when you paste a new column
into an Excel sheet).

3. To save your work, use R’s save() function. This will save it in an Rdata format, which can later be
reloaded with the load() function. In the example below, we save a single object to a file; you can
also pass a list of objects as the first argument to save the collection.

save(ablation, file = "ablation.Rdata")

load("ablation.Rdata")

iv. Subsetting with dplyr

The dplyr package has other functions to help you perform more complex manipulations, and a few others
that will make your life easier. These include subsetting by columns (select()) and subsetting by rows
(filter()). To some extent, these have the same functionality as indexing vectors, but especially as you
start to chain together multiple operations, the dplyr functions will make the intent and readability of
your code much clearer.

1. We can use select() to select columns. We’ll use a new dataset called msleep (which has data about
mammalian sleep cycles) to demonstrate. The select() command below is exactly equivalent to a
selection by column indexing vector.

head(select(msleep, name, sleep_total))

head(msleep[ , c("name", "sleep_total")])

2. Note that the data structure returned here looks a little different to what we are used to. The msleep
dataset is called a tibble, which is essentially a data frame, with some small differences, which include
the way that it is presented. When you print a tibble to the console, it will only display as many
columns as will fit on the screen (while also listing the unseen columns at the bottom), displays the
first 6 rows, and also tells you what data type each column consists of. You can use it exactly as you
would a data frame, and functions that don’t know about tibbles will use it as if it were a data frame
(and in fact, it is).

class(msleep)

3. One of the paradigms in the tidyverse is readability of code, and a powerful tool that is introduced
for this is a “pipe”, or %>%. This is analogous to the pipe in Unix pipelines. The pipe will take the
output from whatever is on the left hand side, and treat it as the first argument to the function
on the right hand side. The %>% operator is loaded automatically once you load any of the dplyr
packages, but comes specifically from a package called magrittr.

msleep %>% select(name, sleep_total) %>% head

msleep %>%

select(name, sleep_total) %>%

head

4. The select() function allows you to treat column names as their numeric position, so that anything
you can do with numeric positions, you can do with the variable names. It is always a better idea to
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refer to variables by name, rather than position; it is much less error-prone, and you don’t have to
preserve order.

Note also that, just as in ggplot, when referring to variables, we never have to refer to the data
frame explicitly.

head(msleep[ , -1])

head(select(msleep, -name))

head(select(msleep, -c(name, sleep_total)))

msleep %>%

select(-c(name, sleep_total)) %>%

head

5. There are also a number of convenience functions that go along with select(). See help(select)

or the dplyr cheatsheet for a complete list of other helper functions.

msleep %>%

select(starts_with("sl")) %>%

head

head(msleep[ , startsWith(names(msleep), "sl")])

Exercise:

a. Select all columns that have “wt” in their names.

b. Select the name, genus and order variable columns.

6. The filter() function is used to select rows, similar to the row indexing vector.

msleep[msleep$sleep_total >= 16, ]

msleep %>%

filter(sleep_total >= 16)

msleep %>%

filter(order %in% c("Perissodactyla", "Primates"))

msleep[msleep$order %in% c("Perissodactyla", "Primates"), ]

7. By default, multiple arguments are chained together with logical AND.

msleep %>%

filter(sleep_total >= 16, bodywt >= 1)

msleep %>%

filter(sleep_total >= 16 & bodywt >= 1)

msleep[msleep$sleep_total >= 16 & msleep$bodywt >=1, ]

Exercise:

a. Select all the rows where the order is Carnivora or Primates.

b. Select all rows where sleep total is between 10 and 15.

c. Select all rows where the sleep total was more than 4 times as long as sleep rem.

d. How would you filter out all rows where brainwt was unknown?

8. Another useful function is arrange() which reorders rows by the values in one or more columns. The
desc() function reverses the direction of the ordering.

msleep %>% arrange(order) %>% head
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msleep %>%

arrange(desc(order)) %>%

head

msleep %>%

select(name, order, sleep_total) %>%

arrange(order, sleep_total) %>%

head

9. It is common to use a column solely to drive ordering, but without actually seeing it.

msleep %>%

arrange(order, sleep_total) %>%

select(name, order) %>%

head

Exercise:

a. Arrange the rows by bodyweight, from largest to smallest, showing only the name and bodywt

columns.

b. Arrange the rows by the length of non-rem sleep.

v. Summarizing data by groups

1. When we were using gather() and spread() earlier we were only rearranging (and optionally sub-
setting) the raw data. In other words, every value in the new data frame could be found in the original
data frame. The dplyr package has functions that allow us to summarize our data (this is also known
as data aggregation).

2. Let’s use a smaller dataset to explore these capabilities. The first function we look at is summarize().
This will run a summary function (like mean()) on a column and return the result in a new dataframe.

ToothGrowth %>%

summarize(meanLen = mean(len))

3. On its own, it will always return a data frame with a single row. This is not terribly useful, though!
We already know other ways of getting this information. Where this becomes extremely useful is in
combination with the group_by() function. This allows you to subset your dataset by a set of one
or more “grouping” variables, and run the summary functions per group.

ToothGrowth %>%

group_by(supp) %>%

summarize(meanLen = mean(len))

The group_by() function allows you to define your unit of interest, here the supplement, and evaluate
one or more expressions in the context of the group. Running the group_by() function on its own
will return the entire dataset, but rearranged into the required groupings. The resultant tibble knows
how many groups there are, and how many observations are in each.

4. You can use combinations of variables to subset your data into groups.

ToothGrowth %>%

group_by(supp, dose) %>%

summarize(meanLen = mean(len), n = n())
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Note that we included two summary functions here. The n() function returns the number of obser-
vations defined by the current grouping. It is generally a good idea to include this information, to
get a sense of how robust the description of that group is, and perhaps later filter by the minimum
number of observations.

You can use your own functions as arguments to the summarize() function, but at this time, you
are restricted to only returning a single value from the summarizing function. There are ways around
this, but they are outside the scope of this class.

5. The final dplyr tool is the mutate() function. Unlike summarize(), which results in a new data
frame, mutate() adds a new column to the input data frame, and computes a value for each row.
Like summarize(), mutate() can output multiple new columns.

ToothGrowth %>%

group_by(supp, dose) %>%

mutate(norm.len = (len - mean(len))/sd(len), max = max(len)) %>%

print(n = 60)

Here, mean() and sd() are computed on the lengths defined by each group, not the lengths of the
entire dataset.

Exercise:

a. Repeat the previous exercise with the msleep dataset, but this time, also add a new variable
with the length of non-REM sleep.

b. How would you check if the sleep total and awake columns for each organism added up to 24
hours?

6. Let’s use our new functions to further explore the ablation dataset. Some recap first:

Exercise:

a. Reshape the ablation dataset so that there is a column for each CellType, and removing the
Direction column.

b. Reshape the ablation dataset so that every unique combination of Time and CellType has its
own column. Again, remove the Direction column.

7. We can chain many operations together. What does this do?

ablation %>%

select(Time, Measurement, CellType, Score) %>%

group_by(Time, Measurement, CellType) %>%

summarize(mean.score = mean(Score)) %>%

spread(CellType, mean.score)

Note that the spread() function refers to a variable newly created by the function directly before.

8. Other examples of useful summary functions include min(), max().

ablation %>%

select(Time, Measurement, CellType, Score) %>%

group_by(Time, Measurement, CellType) %>%

summarize(the.min = min(Score), the.max = max(Score))

9. We can compute the mean and standard deviation within groups too. If we assign these results to a
new data frame, we can use them as input to ggplot.
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ablation.mean.sd <- ablation %>%

select(Time, Measurement, CellType, Score) %>%

group_by(Time, Measurement, CellType) %>%

summarize(the.mean = mean(Score), the.sd = sd(Score))

ggplot(ablation.mean.sd, aes(x = Time, y = the.mean)) +

geom_point(size = 4) +

geom_errorbar(aes(ymin = the.mean - the.sd, ymax = the.mean + the.sd), width = 0.4) +

facet_grid(Measurement ~ CellType) +

geom_line() +

geom_point(data = ablation, aes(y = Score), color = "blue", shape = 1) +

labs(title = "+/- 1 SD")

In the above plot, we used the geom_errorbar() function which requires a unique aesthetic that
binds ymax and ymin to the upper and lower bounds of the error bars.

10. Confidence intervals computed from a t-test are often used as the limits of the error bars, but including
those in a similar figure is a little less elegant, because the summarizing function currently cannot
return more than one value.

ablation.mean.ci <- ablation %>%

select(Time, Measurement, CellType, Score) %>%

group_by(Time, Measurement, CellType) %>%

summarize(the.mean = mean(Score),

lower.limit = t.test(Score)$conf.int[1],

upper.limit = t.test(Score)$conf.int[2])

11. Let’s use the mutate() function to add another column to our data frame, calculating the rate of
ablation. Note that at Time 0, the rate cannot be calculated and is therefore unknown.

ablation %>% mutate(rate = ifelse(Time > 0, Score / Time, NA))

Note the use of the ifelse() function. This is a vector operation that tests the expression given as
the first argument for every element in a vector. If the expression evaluates to TRUE, the second
argument is the result, otherwise the third one is. The mutate() function adds a column to the
ablation data frame with the computed result.

12. When coupled with group_by(), mutate() can compute a value for every line that is a function of
some grouping. In the following example, we use mutate() with group_by() to determine whether
a Score is an outlier within a group of experiments (here we define an outlier as being outside of ±1
SD of the mean.

ggplot(ablation.mean.sd, aes(x = Time, y = the.mean)) +

geom_point(size = 2) +

geom_errorbar(aes(ymin = the.mean - the.sd,

ymax = the.mean + the.sd), width = 0.4) +

facet_grid(Measurement ~ CellType) + geom_line() +

geom_point(data = ablation %>%

group_by(Measurement, CellType, Time) %>%

mutate(outlier = abs((Score - mean(Score)) / sd(Score)) > 1),

aes(y = Score, color = outlier), size = 4, shape = 1) +

labs(title = "+/- 1 SD", y = "Mean") +

scale_colour_discrete(name = "Outlier Status",

labels = c("Within 1 SD", "Outside 1 SD"))
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Here, the data argument to the second geom_point() function is an inline call to dplyr functions.
This is not recommended in practice, but is shown to give you an idea of what is possible. Also, note
that a more appropriate cutoff for outliers is ±3 SD.
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IX Reproducible analysis

To facilitate reproducible analysis, it is a best practice to write a script that loads your raw data, runs your
entire analysis, and produces appropriate plots and output without any intervention. Keeping the script
open in the Source panel in RStudio and checking the Source on Save option can be helpful as you develop
your script.

An example based on the material we have covered in this workshop is shown below.

library(tidyverse) # using ggplot2, dplyr, tidyr packages

analyze.all <- function(save.plots = TRUE) {

# Load data

ablation <- read.csv(file = "Ablation.csv",

header = TRUE,

stringsAsFactors = TRUE)

names(ablation)[names(ablation) == "SCORE"] <- "Score"

print(ablation)

ablation.means <- ablation %>%

group_by(CellType, Measurement, Time) %>%

summarize(mean = mean(Score), n = n())

print(ablation.means)

# Set up plotting

if (save.plots) {

pdf(file = "plot.pdf")

}

# Plot all data

g <- ggplot(ablation, aes(x = Time, y = Score)) +

geom_point() +

geom_line(aes(color = Experiment)) +

facet_grid(Measurement ~ CellType) +

theme_bw()

print(g)

# Plot averages over experiments

g <- ggplot(ablation.means, aes(x = Time, y = mean)) +

geom_point() +

geom_line(aes(color = CellType)) +

facet_wrap(~ Measurement) +

theme_bw()

print(g)

# Separate plots of averages over experiments

for (measurement in levels(ablation.means$Measurement)) {

g <- ggplot(ablation.means %>%

filter(Measurement == measurement), aes(x = Time, y = mean)) +

geom_point() +
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geom_line(aes(color = CellType)) +

labs(title = measurement) +

theme_bw()

print(g)

}

# Close plotting device

if (save.plots) {

dev.off()

}

}

analyze.all(FALSE)

Note the use of for loops and if blocks. Control structures such as these are often needed to ensure your
script can run autonomously. Here we use an if block to control whether plots are saved to a PDF or
viewed in RStudio, a technique that can be handy when developing your script.

Also note that the script works when invoked with the appropriate working directory and with an empty
environment. It is important that you test this to ensure that you are not dependent on some objects left
in your workspace from interactive sessions.

We close by noting that some journals, such as PLoS One, are now requiring scripts such as these to address
the problem of imprecise or incomplete descriptions of analysis methods.
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